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Path Editing 

In this lesson, we’re going to explore ways to modify paths and shapes, otherwise 
known as vector tools. When you use a vector tool, you are not creating pixels 
(like you would find in a normal photograph). Instead, you are creating paths, 
which are a series of dots that are connected with straight lines or smooth curves. 

If you are not used to using the Pen Tool to create paths and shapes, know that 
there is a separate Masters Academy lesson that teaches you how to use the Pen 
Tool. That skill will be crucial for following along with this lesson.

You can access that video here: https://mastersacademy.com/course/vid029/

NOTE: I have also included the handbook for that Pen Tool lesson at the end of 
this PDF, in case you need a refresher!

Once you learn the basics and know how to create shapes and paths, you can 
then use those to fill an area via a shape layer or to limit where a layer appears 
via a vector mask. Then you can get more sophisticated by combining more than 
one shape together.

Path Basics & Paths Panel (Timestamp 1:35)

Start with a new, empty Photoshop document and activate the Pen Tool. When 
creating a shape with the Pen Tool, a single click will place a point that will have a 
hard edge and create a straight line segment. Click and drag to create a smooth 
curve. Click back on the first point to close the shape. 

The Pen Tool is being used 
to create a path shape. 

https://mastersacademy.com/course/vid029/
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The Paths Panel is grouped with the Layers 
Panel on the right side of the screen. After 
you create a path, it will appear in this pan-
el. In the path thumbnail, the white part is 
the area that you defined. The path will be 
named “Work Path” unless you change it. 
If the Work Path is active and you use the Pen Tool to create another shape, this 
shape will be added to the Work Path. If the Work Path is no longer active when 
you create another shape, this shape will REPLACE the existing Work Path. You 
can think of the Work Path as something that’s fleeting. It is a temporary path 
that will go away unless you name it. If you name the path (by double-clicking on 
the path name), and then click away from it so that it’s no longer active, you can 
use the Pen Tool to create another shape and this will create a NEW Work Path. 

TIP: You can change the size of the thumbnails in the Paths Panel by right-click-
ing in an empty part of the panel. A pop-up menu will give you three different 
thumbnail size choices. 

The Pen Tool was used to create a path, but that path isn’t doing anything yet. It 
could be attached to a layer as a vector mask so it would limit the layer’s visibility. 
The mask would only allow the layer to be visible in the areas where the path is 
white (in the path thumbnail). You could also use the path to apply a vector mask 
to a new solid color layer, otherwise known as a Shape Layer. 

Two overlapping shapes were 
made using the Pen Tool. In the 
Paths Panel, the white part of 
the thumbnail depicts the shape 
that’s being defined. 
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How to Make Paths Interact (4:48)

If you have a path with multiple components, you 
can control how the active component of the path 
will interact with the others. The active compo-
nent of the path will have the points visible. Click 
on the Path Operations icon         in the Options 
Bar (above the image window) and a menu will 
present you with the following options. 

Combine Shapes This option will combine the 
shapes into one single path component. 

Subtract Front Shape This will cause the active 
component to create a hole in the other parts of 
the path. 

Intersect Shape Areas This will only keep the 
area where the active component overlaps with 
the others. 

Exclude Overlapping Shapes This option will cre-
ate a hole in the area where the active path com-
ponent overlaps with the other component[s]. 

Merge Shape Components Once the paths com-
ponents are interacting in the way that you want, 
you can merge the result by choosing this option. 
This will create one single, continuous path com-
ponent and remove any visible paths that are not 
part of the final shape. 

To save the path, double-click on the name “Work Path” and give the new path a 
name. 

When you hover the Pen Tool over the document window, an asterisk will 
appear next to the tool tip, indicating that you’re about to create a new, 
independent component of the active path. 

Active Path

Front shape was 
subtracted

Paths were  
intersected

Path excludes 
overlapping 
shapes

Front shape was subtracted, then 
we merged shape components.
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The Path Selection Tool & Direct Selection Tool (8:40)

Now let’s look at how the Pen Tool relates to 
the Path Selection Tool and the Direct Selec-
tion Tool. When you use the Path Selection 
Tool to click on a path, it selects the entirety 
of the path. All of the points that make up the 
path will turn black to indicate that they’re 
active. When the entire path is active, you can 
click and drag on it to move the entire shape. 

When you use the Direct Selection Tool to 
click on the path, it will not select the entire 
shape. The points that make up the path will 
become hollow, which means that they’re not 
active. You can then use the Direct Selection 
Tool to click and drag on Independent parts 
of the path. You can drag an individual point, 
one of the handles that extend from a point or 
an individual path segment. 

Command key to switch between tools 
When either the Path Selection Tool or 
the Direct Selection Tool is active, you can 
easily switch to the other tool by holding 
down the Command key (Ctrl on Win). As 
soon as you click somewhere, it will offi-
cially switch to the other tool. If the Path 
Selection Tool is active, you can hold down 
the Command key and you will see the tool 
tip change to the Direct Selection Tool. As 
soon as you click in the document, it will 
keep the Direct Selection Tool active. The 
same goes when it’s the other way around. 

The Path Selection Tool is being used 
to move the path as a whole.

The Direct Selection Tool is used to 
move an individual point on the path.
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When the Direct Selection Tool is active, you can select and move more than one 
point at a time by holding down the Shift key to click on additional points. 

Modify a Shape Path (11:10)

Add a point There are a few different ways that you 
can modify a shape. With the Pen Tool active, you can 
hover your cursor over a path line and you will see a 
little plus icon appear next to the tool tip. This indicates 
that a new point will be added when you click on the 
path. When you add a new point, it will attempt to not 
change the shape of the existing path. 

Move a point If you want to move that new point, you will need to use the Direct 
Selection Tool and there is a fast way of accessing that. When the Pen Tool is 
active, hold down the Command key (Ctrl on Win) and it will temporarily switch 
to the Direct Selection Tool, as long as you have the key held down. When you 
release the Command key, it will go back to using the Pen Tool. 

Remove a point To remove a point, use the Pen Tool to 
hover your cursor over the point you want to remove. 
A little minus icon will appear to the right of the tool 
tip. When you click, it will remove that point from the 
path line. When you remove a point from the path, it 
won’t sever the path line. It will instead connect the ex-
isting points to create a continuous shape. 

Break the path You can break a 
path by using the Direct Selection 
Tool to select the point (or points) 
you want to remove. Then tap the 
Delete key. This will remove the 
points and sever the path line so 
that it is no longer continuous. 

The point was selected and then we tapped the 
Delete key to remove it and break the path.
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To connect broken path lines, first make sure the end point that you want to con-
nect is active. Then click on the end point on the other broken segment where 
you would like the path line to be attached. 

Combining Paths (15:13)

After naming the Work Path so that it is no 
longer temporary, you can create addition-
al paths and these will all appear in the Paths 
Panel (Just remember to name them to make 
them permanent.) We already talked about 
how you can control the way components of 
an individual path interact. Now let’s look at 
how you can make separate paths interact. 

Here, we closed a broken path line by clicking on the end points to be connected.
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Merge paths To merge two paths together into one path, make sure the first path 
is active, click on the Edit menu and choose copy. Then activate the second path, 
click on the Edit menu and choose paste. 
The copied path will be pasted into the 
active path. Then, you can use the menu 
in the Options Bar to determine how the 
individual path segments should interact. 
Note that the stacking order of the path 
segments will have an effect on how the 
paths are merged. For example, the first 
shape you created will be at the bottom of 
the stack. If you were to select this shape 
and then choose the Subtract option, 
nothing would happen because a shape 
can only subtract from what is below it. 
You can change the stacking order using 
the Stacking icon in the Options Bar. 

The Pen Tool Handbook

The following pages contain the handbook for the lesson referenced earlier that 
covers the Pen Tool. You can access that lesson video at the following link: 

 https://mastersacademy.com/course/vid029/

https://mastersacademy.com/course/vid029/
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The Pen Tool in Photoshop

In this lesson, we’re going to cover the basics of the Pen Tool in Photoshop. The 
Pen Tool can be used to draw shapes, select objects or to mask a layer so that it 
only shows up inside a particular shape. The Pen Tool is good for defining areas 
that are made up of straight lines and smooth curves. It is not good for selecting 
things that have soft edges, fuzz or fluffy hair. 

The Pen Tool can be found in the Tool Bar 
on the left side of the interface. If you click 
and hold on the Pen Tool icon, you will see 
that there are different versions of the tool 
that you can choose from. When you use 
the Pen Tool, you are creating a path. Once 
you have a path in your document, you can 
do one of three things with it, and these op-
tions can be found in the Options Bar above 
the main image window.  

•	 Selection: This option will convert the path into a selection.

•	 Mask: Choosing this option will turn the path into a mask, attached to the ac-
tive layer.

•	 Shape: This will create a shape layer out of your custom path just as if you 
used the Shape Tool. 

The second tool hidden behind the Pen Tool icon is the Freeform Pen Tool. When 
activated, you can use this tool to click and drag out a shape in a similar way that 
you would use the Lasso Tool. As long as you let go of your mouse button in the 
same place that you started, you will end up with a closed path. While this may 
be the easiest of the Pen Tool options, I find I use this one the least. 

If you click and hold on the Pen Tool 
icon in the Tool Bar, you will have access 
to all the versions of the tool.

Once you have a path, 
you can use these op-
tions to tell the path 
what to do.
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The version of the tool that I use the most is the regular old Pen Tool, and this is 
the top option as well as the default option for the tool. 

Creating a shape made of straight lines The simplest kind of path to create is 
one that is made up of all straight lines. With the Pen Tool active, click in your 
document to add a point. Then click somewhere else to create a second point 

with a straight line connecting them. Keep 
clicking to add points, creating the shape 
you desire. In order to create a finished, 
closed path, you will need to click back in 
the same place that you started. When you 
hover your cursor over that place, your cur-
sor will get a little circle icon next to it, indi-
cating that you are about to close the path.

Creating a shape made of curved lines If you click and drag with the Pen Tool, 
you will create a point with handles attached to it. These handles determine what 
direction the line will travel in when it moves away from the point. When cre-
ating a path for a curved object, you want to think about the different curves 

that the object is made out of. The points 
should be placed in the areas where one 
curve transitions into another curve and 
you would click and drag, placing points 
with handles in each of these areas. The 
length of the handle will determine how 
strongly it influences the direction of the 
line. A short handle will force the line to 
follow that direction for a short distance. 

The circle icon appears next to the cur-
sor when you’re about to close the path.

Here is an example of when 
a straight-lined path is very 
useful. I wanted to mask 
everything except for the X 
in this layer. I used the Pen 
Tool to make a path around 
the X and then I chose 
Mask from the choices in 
the Options Bar. 

The length of the  
handles determine how 
strongly they influence 
the direction of the 
curve.
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A long handle will force the line to follow that direction for a longer distance be-
fore deviating toward the next point. 

It takes a little while to get used to know-
ing how long the handles should be. The 
following technique will help with that. The 
Direct Selection Tool can be found in the 
Tool Bar and it is designed to modify a path 
that you’ve already created. You can use it 
to click on the different points to make the handles re-appear so that you can 
modify them or you can use it to click and drag on the path itself. When dragging 
on the path itself, it will automatically change the length and angle of the han-
dles on either side of the path segment. I like that this changes the length of the 
handles, but I don’t want this to change the angles of the handles. I can specify 
this by turning on the “Constrain Path Dragging” check box in the Options Bar 
(when the Direct Selection Tool is active). If I do this, I can quickly create a path 

and then drag all of the curve segments to 
fine-tune how long the handles are, therefore 
perfecting the curve. If a curve is still slightly 
off, it means that you will have to adjust the 
direction of the handles.

You can access the Direct Selection tool while 
you’re in the Pen Tool by holding down the 
Command key (Ctrl on Win). The entire time 
you have the Command key held down, you 
will be using the Direct Selection Tool. When 
you let go, you will get the Pen Tool again. 

If you have a path that’s already completed, you may find that 
you need to add a point in order to change or fine-tune the 
path. With the Pen Tool active, hover your cursor over the path. 
You will see a little plus (+) symbol appear next to the cursor 
and this means that you can click on the path to add a new 
point. You can then hold down the Command key to access the 
Direct Selection Tool to adjust the handles of the new point.

The Direct Selection Tool can be found 
hidden behind the Path Selection Tool.

The Direct Selection Tool is used to 
drag the curve into the best position.

The plus symbol 
indicates that you 
can add a point 
to the curve.
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Creating a path with abrupt corners When you click and drag, you get handles 
that come out of both sides of the point, creating a smooth curve. If you need to 
create a sharp angle, activate the Convert Point Tool, which can be found behind 
the Pen Tool icon in the Tool Bar. With the Convert Point Tool active, you can click 
and drag on the handles to move them independently of each other and create a 
sharp, angled transition in the path. To change a point that has a sharp angle and 
make it smooth again, use the Convert Point Tool to click on the point and drag 
out new handles. 

Note that you don’t have to manually use the menu 
to access the Convert Point Tool. There is an easy 
way to access it while using the Pen Tool. With the 
Pen Tool active, hold down the Option key (Alt on 
Win) to temporarily access the Convert Point Tool. 
The entire time you have the Option key held down, 
you will be using the Covert Point Tool. When you 
release the key, it will switch back to the Pen Tool. 
This makes it very easy to create both curved lines 
and sharp edges while creating a shape with the 
Pen Tool. 

Sometimes, you will need your path to have a curve on one side of a point and 
a straight line on the other side of the point. With a point that has two handles 
creating a smooth curve, hold down the Option key (Alt on Win) to temporarily 
access the Convert Point Tool and click once on the point. This will remove the 
handle on the open end of the path. To create a handle on a point that doesn’t 
have one already, hold down the Option key while you click on the point and drag 
out a handle. 

Pen Tool Options In the Options Bar, there is a menu on 
the left side where you can decide whether you want to 
use the Pen Tool to create a Shape or a Path. I usually 
keep this set to Path. The options next to “Make:” will tell 
Photoshop what to do with your path. You can take a 
path and convert it into a selection, apply it as a mask or 
create a shape layer from it. 

The Convert Point Tool will 
allow you to move the handles 
independently of each other, 
creating a sharp angle instead 
of a smooth curve. 

With the Pen Tool active, 
you can decide whether 
you want to use it to cre-
ate a Shape or a Path. 
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The icon that looks like two overlapping 
squares will give you a menu where you 
can choose what happens if you draw 
an additional shape while the previous 
shape/path is still active. For example, 
if you choose the Subtract option, the 
current shape will create a hole in the 
previous shape in the areas where the 
two overlap. 

The Paths Panel After you have created a path, it will appear inside the Paths pan-
el, which is usually hidden behind the Layers panel. If the Paths panel is not visible 
on your screen, you can access it by going to the Window menu and choosing 
Paths. By default, the active path will be called the Work Path, and this indicates 
that it’s a temporary path. If you would like to make the path more permanent, so 

that you can hide it and then access it again later, 
double click on the text “Work Path” and give it a 
new name. This will save the path for future use 
and it will allow you to have a new Work Path. To 
work on a path that you previously saved, simply 
click on it in the Paths panel and it will become 
visible in your document.

Creating a mask from a path As we covered ear-
lier, you can convert an active path into a layer 
mask by clicking the Mask button in the Options 
Bar at the top of the interface. When you do this, 
the layer mask will appear as a thumbnail next to 
the layer thumbnail in the Layers Panel. There will 
be brackets surrounding both thumbnails, indicat-
ing that both the layer and the path are active. You 
will still see the path in your document. To hide the 
path, simply click on the layer mask thumbnail to 
remove the brackets. Click on it again to make the 
path visible (and editable) again.  

This menu will determine how two paths will 
interact with each other.

The Paths panel can usually be 
found hidden behind the Layers 
panel. 

The path is active in the top 
screen shot and inactive in the 
bottom one.
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Visual Recap

A: Point

B: Path Segment

C: Handle

A path made up 
of points with no 
handles

A path made up of 
points with handles 
creating one smooth,  
continuous line. 

A path made up of 
points with handles 
that create curves 
but point in different 
directions, creating 
abrupt transitions.

A path that combines 
different types of  
handles that create 
different types of  
transitions.


